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Introduction 
By following this tutorial you will use MX Kollection 3 to build a basic Image Gallery web application. 
The final application will allow users to: 

 View a list of all uploaded images. 

 Upload new images. 

 Delete images from the server. 

 View and browse all images. 

 View a random image each time the gallery is reloaded in the browser. 

 View thumbnails of the latest images. 

 Organize images into albums. 

 Change the basic design of the image gallery using Cascading Style Sheets. 

This tutorial contains three main sections 

1. Building the administrative section where you will manage all images. 

2. Displaying images in the site front-end and creating the actual gallery. 

3. Improving the basic application and grouping images into albums. 

 

If you have the MX Kollection 3 bundle installed, then you have all the needed tools. Otherwise, the 
following separate products should be installed on your computer in order to complete the Image 
Gallery tutorial: 

 MX File Upload 

 MX Looper 

 MX Includes 

 MX Form Validation (optional) 

 MX User Login (optional) 

The estimated completion time for this tutorial is about 40 - 60 minutes. It depends on your authoring 
knowledge with Macromedia Dreamweaver (MX or MX 2004) and MX Kollection 3. 

It's recommended that you follow this tutorial in the intended order to avoid potential problems. 
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Plan the Image Gallery 
Before you start building the image gallery, please make sure that: 

1. You have a running database server and web server. 

2. You have installed the following extensions for completing this tutorial: 

 MX File Upload 

 MX Looper 

 MX Includes 

 MX Form Validation (optional) 

 MX User Login (optional) 

3. You have a correctly defined Dreamweaver site. 

4. You need to set up the database provided with this tutorial and create a connection to it. 

For more instructions about setting up your site, consult the Getting Started help file that comes 
with MX Kollection 3. It can be accessed in Dreamweaver from Help -> InterAKT -> Getting 
Started. 

 

The image gallery will store information in a database having two tables with the following structure: 
 

 

 

Note: The database diagram in the image above was built with MX Query Builder (also referred as 
QuB) to better illustrate the database structure. You do not need to build it in order to complete this 
tutorial. 

 

Here are the database tables and their columns: 

1. album_alb - stores all albums and some simple information about them. 

 id_alb - the primary key for the album table. No two albums can have the same ID. 

 title_alb - the album's title (Florida 2004). 

 description_alb - a text description of the album. 

 date_alb - the date associated with the album. 

2. image_img - stores the filename of the image, a short description of each image, and the 
date when it was uploaded. It also points to the album the image belongs to through the foreign 
key idalb_img. 

 id_img - the primary key for the image table. There will not be two images with the 
same ID. 

 idalb_img - the foreign key that connects to the associated album. 
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 filename_img - the image filename. 

 description_img - a brief text description of the image. 

 date_img - the date associated with the image. 

 

The actual images are not stored in the database, but uploaded to the server. They can later be 
retrieved by their filename, which is stored in the database. 

To set up your application, follow these steps: 

1. You can find the scripts needed to create an identical table structure inside the downloaded 
package, in the \tutorials\Image Gallery\db\ folder, as an sql or mdb file, depending on 
the database server you intend to use. Execute the sql script in your database server 
management software (e.g. PHPMyAdmin, Microsoft Access etc.). 

2. Open Dreamweaver and create the following folder and file structure for your site. You can 
create it easily by unpacking the zip file corresponding to your server model from 
\tutorials\Image Gallery\ in your site root folder: 
 

 
  

3. Open the index page and create a new connection named connGallery and configure it to 
connect to your newly created database. 
 

 

 

Starting with the next part you will learn how to upload, list and delete images. 
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Manage Images 
In this part of the tutorial, you will create the administrative section of your image gallery which 
allows you to upload images, list all the images on the server and delete images. 

In order to process images on upload and display, you must have one of the supported image libraries 
installed on your server and properly configured. Please make sure you have defined a preferred 
image library in the InterAKT Control Panel. 

If you have the MX Kollection 3 bundle installed, then you have all the needed tools. Otherwise, the 
following separate products should be installed on your computer in order to complete this tutorial 
section: 

 MX File Upload 

The estimated completion time for building the image management module is about 20 - 30 minutes. 
The exact time depends on your authoring knowledge with Macromedia Dreamweaver (MX or MX 
2004) and MX Kollection 3. 
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Upload image 
To create a form for uploading images, follow these steps: 

1. Open the \admin\upload_img page. 

2. Use the Insert Record Form Wizard to create an insert form for uploading images. You can 
access the wizard from the Insert bar -> MX Kollection -> Insert Record Form Wizard. 
Configure the dialog box as indicated below. 

3. In the first step of the wizard, specify the following: 
  the defined database Connection; 
  In the Insert into table select the table that stores image data - image_img; 
  the Primary key column; 
  the page to redirect to (list_img) after uploading an image. 
 

 
  

4. Click Next to proceed to the second step, where you will configure the individual form fields: 

 Remove the foreign key field (idalb_img) as you will not need it for the moment. 

 Change the filename_img field to a file field from the Display as drop-down 
menu. Also change its Label to "File". 

 Change the description_img field to a text area from the corresponding Display 
as drop-down menu. 

 Change the date_img field to be displayed as text and set its default value to 
{NOW_DT}. This uses the InterAKT's mark-up language to set the field's value to the 
current date and time. This way, you won't have to set up a value for this field. The 
current date and time will be recorded in the database each time an image is 
uploaded.  

 After completing the wizard, you must remove the row which displays the date 
(using the text element instead of a hidden field is more safe). 
 
Note: If you are using a Microsoft Access database, in the Submit as drop-down 
menu, another option will be available: Date MS Access. Select this option when 
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submitting the date. 
 

 

5. In the final step of the wizard, make the filename_img field required, then click Finish. 
 
Note: If you do not have MX Form Validation or the MX Kollection 3 bundle installed, 
step 3 of the Insert Record Form Wizard will not be available. 
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6. Remove the date text field from the form on page. 

7. Apply the Upload and Resize Image server behavior to the generated form from the 
Application panel -> Server Behaviors -> + -> MX Kollection -> File Upload -> 
Upload and Resize Image. 

8. Configure the Basic tab of the server behavior as follows: 

 Select the Form field used for uploading pictures: filename_img from form1. 

 Select the Table column that stores the name of the image: filename_img. 

 Use the Browse button to select the folder where images will be uploaded: images. 

 Resize all images to fit within a 800 pixels by 600 pixels box. 

 Move on to configuring the next tab. 
 

 

9. Configure the File tab of the server behavior as follows: 

 Set the Maximum file size to 200 KB. Users will not be able to upload images 
larger than that. 

 Specify the image extensions allowed for uploading. Use the Plus (+) button to add 
new extensions and the Minus (-) button to remove extensions. To add a file 
extension, just enter the extension name in the displayed pop-up window. 
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 Sometimes the uploaded file has the same name as another file on the server. For 
such cases, use the options in the File Renaming drop-down menu. Use the 
Automatic renaming option to give the current file a new name. For instance, if 
you attempt to upload a file called landscape.jpg and there is already another file 
with the same name on the server, the new file will be renamed 
landscape_1.jpg. 
 
 

 

10. Click OK to confirm your settings. 
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Now you can preview the page in the browser, and see how it works: 
 

 

 

If you try to upload an image larger than 200 KB, the following error is displayed. 
 

 

After the image upload is completed, you will be redirected to the page specified when you configured 
the first step of the Insert Record Form Wizard. 

You have created the page for uploading images to your gallery. In the next part you will create a list 
of all your images. 
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List images and show thumbnails 
For a better management of your gallery, follow the next steps in order to create a list with all your 
images: 

1. Open the \admin\list_img page. 

2. Create a recordset that retrieves data from the image_img database table. 

 Click on the Plus (+) button of the Bindings tab. If the Bindings tab is not visible, 
open it from Window -> Bindings. 

 From the pop-up menu that appears, select Recordset (Query). This will open the 
Recordset dialog window. 
 

 
 

 Name the recordset rsImages. 

 Select the database Connection (connGallery) and the Table that stores images 
(image_img). 
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 Sort the images by date in descending order to list the most recent images first. 
 

 

3. List all images using a dynamic table (Insert bar -> Application -> Dynamic Table): 
 

 

4. Configure the dynamic table as seen in the following image: 
 

 
  

5. Trim the generated table as follows: 

 Dlete the first column containing the primary key. 

 Change the column headings to something more meaningful. 

 Remove the dynamic text labeled as rsImages.filename_img. You will replace this 
later with an actual preview of the image (an image thumbnail). 
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6. Your table should look like this by now: 
 

 

7. In the empty cell, below insert a thumbnail view of the image, by applying the Show 
Thumbnail server behavior (Application panel -> Server Behaviors -> + -> MX 
Kollection -> File Upload -> Show Thumbnail). 
 

 
  

8. An interface like the one below is displayed. 
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9. The Show Thumbnail icon will look like in the following image in your Dreamweaver 
Design View: 
 

 

10. Save your page and preview it in the browser: 
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You have created the image list for managing your photos. Next, the possibility of 
deleting images will be implemented 



InterAKT Online   Image Gallery Tutorial 

 

_________________________________________________________________________________ 

http://www.interaktonline.com/ - 17 – 

 

Delete image 
Before proceeding with this section and deleting images from your gallery, one thing must be 
acknowledged: images are both stored on the server and recorded in the database. When removing a 
record, the images also need to be physically removed from the server. This can be done by using a 
Delete File server behavior. 

Rather than automatically deleting the image, you will set up a safety net where users must confirm 
the deletion. You will also display a preview of the image before deleting it. 

Follow the next steps to build the page that deletes photos: 

1. Open the \admin\list_img file. 

2. Add an extra column to the dynamic table by selecting the whole table and incrementing the 
Cols field in the Properties panel. 
 

 
 
This column will contain a link to the page for deleting photos (delete_img). 

3. In the extra column, on the same row as the dynamic data write the word "Delete". Then, 
select the "Delete" text and right-click to reach the menu seen below. Select the Make Link 
option: 
 

 

4. An interface will appear to help you create the link. Since the delete page will need to know 
which image to delete, you should add an URL parameter with the image ID (stored in the 
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id_img primary key field). Click the Parameters button in the lower right side of the 
interface: 
 

 
 

5. When the Parameters window opens, type id_img in the Name field. For the Value field, 
click in the empty space and select the dynamic lightning bolt on the right: 
 

 

6. After clicking the lightning bolt, the Dynamic Data window appears. Here, just double-click on 
id_img and the Value field (from the previous window) will be populated. 
 

 

7. With the Dynamic Data window now closed, click OK in the Parameters window, and you'll 
be back in the Make Link Interface. All that's left is choosing the page to link to. Select the 
delete_img page from the admin folder. 
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The next set of steps take place in the delete_img page from the admin folder. The goal here is to 
create a confirmation page to prevent accidental deletions. 

1. Open the \admin\delete_img page. Type the message "Are you sure you want to delete 
this image?". 

2. You need to display the details of the image: a thumbnail preview, the filename, and the 
description from the database. In order to do so, create a recordset from the image_img 
database table, filtered by the id_img URL parameter. 

3. As you remember from the previous part, a recordset can be created from the Bindings tab 
in the Application panel. Configure the recordset as shown below. The Filter field selects 
only the image to be deleted by comparing its ID value with the one received through the 
URL parameter from the list_img page. 
 

 

4. Drag the filename_img and the description_img columns from the Bindings tab in your 
page, below the confirmation question: 
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5. Add a thumbnail preview of the image, below the filename dynamic text, so the user can see 
the image being deleted. Hit Enter after {rsDeleteImage.filename_img}, then go to 
Server Behaviors -> MX Kollection -> File Upload -> Show Thumbnail. Configure the server 
behavior just as you have done in List images and show thumbnails, except use larger 
dimensions for the thumbnail (100x100 pixels). Here is how the page should look in the 
browser, if you pass it a valid URL parameter (such as page.php?id_img=2): 
 

 

6. Below the confirmation dialog, add a form by selecting Insert panel -> Forms -> Form (as 
shown below): 
 

 
 

7. Next, add a button to the form, also from the Forms tab: 
 

 

8. Select the button on the page, and go to the Property Inspector. Change the Button 
name to confirm and its Label to Yes. 
 

 

9. Repeat step 7 and create another button called cancel, and labeled No in the same form. 

10. Now you should make the No button link back to the image list page (list_img). First 
select the No button. Depending on your Dreamweaver version, the Go To URL feature will 
be in one of two places: 

 For Dreamweaver MX 2004 users - open the Tag Inspector panel, the 
Behaviors tab, and select Go To URL. 
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 For Dreamweaver MX 6.1 users - open the Design panel, the Behaviors tab, and 
select Go To URL. 
 

 

 In the interface that appears, select list_img as seen here: 
 

 

11. Now you can use the Delete Record Transaction feature of MX Kollection 3. Go to the 
Insert bar -> MX Kollection tab, and click the Delete Record Transaction icon (shown 
below). 
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12. Configure the Delete Record Transaction window. Notice that most of the fields are 
already correctly filled in: Connection, Delete from table, Primary key column and 
Primary key equals. 

13. If left like this, the delete operation would occur immediately when the page loads, making 
the safety net completely useless. There is however one dialog box option to define a start 
condition: the First check variable field. To start the delete action only after pressing the 
Yes button, select in the First check variable drop-down menu the Form variable option. 
Type in the associated dialog box the name of the Yes button: confirm. 
 

 

14. Since all other fields are already set up, click the OK button to add the server behavior to the 
page. 

15. The Delete Record Transaction removed the image from the database. However, you also 
need to remove the actual file from the server. In order to do that, you need to apply the 
Delete File server behavior to your page (Server Behaviors panel -> MX Kollection -> 
File Upload -> Delete File). 

16. Configure the Delete File server behavior as follows: 
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Notice that the field storing the image name (filename_img) and the folder are already 
selected in the Table column drop-down menu and File folder text field. 

17. Click OK when done. 

 

You can now test the delete_img page in your browser. The page should look something like this:  
 

 
  

Note: If you delete an image from your gallery, the delete_img page will remove the corresponding 
record from the database, and will remove the actual file and all generated thumbnails from the 
server. 
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You have now completed the administrative section of your image gallery application. You can upload, 
view and delete images. Next, you will start learning how to display images in the site front-end. 
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Display Images 
In this section you will use the Show Image server behavior and a Horizontal Looper to create a 
page for browsing through thumbnails and a page for showing each full-size image. 

 

If you have the MX Kollection 3 bundle installed, then you have all the needed tools. Otherwise, the 
following separate products should be installed on your computer in order to complete this tutorial 
section: 

 MX File Upload 

 MX Looper 

The estimated completion time for this section is about 20 - 25 minutes. It depends on your authoring 
knowledge with Macromedia Dreamweaver (MX or MX 2004) and MX Kollection 3. 

 

This section contains the following parts: 

 Browse thumbnails: Horizontal Looper 

 Display full-sized image 
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Browse thumbnails: Horizontal Looper 
In order to create a page for browsing through thumbnails, follow the next steps: 

1. Open the thumb_view page. 

2. Create an unsorted recordset with all the records from the images_img table. The two 
previous tutorial parts (List images and show thumbnails and Delete Image) demonstrate 
how to create a recordset. You will use this recordset to extract the filename of the 
thumbnails, when applying the Show Thumbnail server behavior at the next step. 

3. Apply a Show Thumbnail server behavior on this page as you did in Step 7 of the List 
images and show thumbnails page. 

4. Now, we will create the image gallery by applying the Looper Wizard feature of MX Looper. 
This feature will loop through the images in the database and place thumbnails on the screen 
(MX Looper required). 

 Select the Show Thumbnail icon. Then go to Insert panel -> MX Kollection -> 
Looper Wizard (seen below): 
 

 
 

 The following interface will appear. Specify the table dimensions of your choice, then 
click OK. 
 

 

 After inserting the looper, you should see the following icon on your Dreamweaver 
page:  
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5. Link the thumbnail image to a separate page where the full image will be shown: 

 First, select the Show Thumbnail icon in your Dreamweaver page and right click on it. 
In the menu that appears, select the Make Link option. 

 Follow the procedure described in the Delete image page. You will need to add an URL 
parameter with the id_img field and link to the full_view page. 
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Display full-sized image 
In order to create a page for page for showing each full-size image, follow the next steps: 

1. Open the full_view page. 

2. Create a filtered recordset containing the id_img URL parameter as described in the Delete 
image page. 

3. Apply the Show Image server behavior to properly display the file. Access it by going to 
Application panel -> Server Behaviors -> + -> MX Kollection -> File Upload. 
 

 

4. When the interface appears, the fields should already be filled in. Verify the folder, recordset, 
and recordset column (the one with the image in it) and click OK. 
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5. All that is left to do is adding the image description. Just drag the corresponding recordset 
field and drop it under the dynamic image (as described in the Delete image page). 
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Improve the Image Gallery 
In this section, you will create some advanced features for your image gallery. You will learn how to: 
display a random image on the home page, show the latest uploaded images, create multiple albums, 
renew the design of the image gallery, apply Cascading Style Sheets to your gallery. 

 

If you have the MX Kollection 3 bundle installed, then you have all the needed tools. Otherwise, the 
following separate products should be installed on your computer in order to complete this tutorial 
section: 

 ImpAKT 

 MX File Upload 

 MX Looper 

 MX Includes 

The estimated completion time for the gallery improvements is about 40 - 60 minutes, depending on 
your authoring knowledge with Macromedia Dreamweaver (MX or MX 2004) and MX Kollection 3. 
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Display random image 
In this tutorial section you will modify the default.php page to show a random picture each time 
the page is reloaded. 

1. Open the default.php page. 

2. Create a new recordset. This will retrieve from the image_img table all the image details, and 
will also make use of the SQL function RAND() to associate to each entry a random number. 
Then, the entire recordset will be ordered by the random number that was generated. This 
ensures that all images in the table get an equal chance of being displayed. 

3. To create the recordset, click on the Plus (+) button of the Bindings tab. Since the SQL query 
is more complex than the Simple interface can handle, click on the Advanced button. Fill in 
the dialog box options as follows: 

 In the Name text field enter the recordset's name: rsImages. 

 In the Connection drop-down menu, select the database connection defined at the 
beginning of this tutorial (connGallery). 

 In the SQL text area you must enter the code that will retrieve the records. Copy and 
paste the code below: 
 
SELECT *, rand() as random_number 
FROM image_img 
ORDER BY random_number DESC LIMIT 1  

 Click on OK to add the recordset to the page. 
 

 

4. Apply the Show Thumbnail server behavior using the rsImages recordset (as described in 
the Delete image page). 

5. You should now be able to load the page in a browser and see a random image from your 
database. You can refresh the page a few times to see different  images. 
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Show latest images 
In this section, you will edit the default.php page of the gallery in order to make it display, below the 
random image, the thumbnails of the 5 most recently uploaded images. 

1. In order to retrieve only the latest 5 images, create a recordset (rsLastImg) that uses the 
following SQL code (use the Advanced view): 
 
SELECT id_img, idalb_img, filename_img, date_img 
FROM image_img 
ORDER BY date_img DESC LIMIT 0,5 
       
If you are using ColdFusion, use the following code (no matter the database type): 
 
SELECT id_img, idalb_img, filename_img, date_img 
FROM image_img 
ORDER BY date_img DESC 
 
and then edit  the <cfoutput> tag to make it look like this: <cfoutput 
query="rsImages" maxrows="5"> 
 
If you are using Microsoft Access, you can create the recordset with the following code: 
 
SELECT TOP 5 id_img, idalb_img, filename_img, date_img 
FROM image_img 
ORDER BY date_img DESC 
  

2. Create a new paragraph below the Repeat Region already existing on the page. 

3. Apply a Show thumbnail server behavior configured to use the rsLastImg recordset to 
retrieve the file name. 

4. Apply the Looper Wizard from the MX Kollection tab of the Insert panel and configure it 
as follows: 

 In the Recordset drop-down menu select rsLastImg. 

 Select the All records radio-button. This will disable the number of Rows setting, 
leaving only the number of Columns available for modification. Since the recordset only 
retrieves 5 records, and the best way to display them is in a row, enter 5 for the number 
of columns to use with the Horizontal Looper. 



InterAKT Online   Image Gallery Tutorial 

 

_________________________________________________________________________________ 

http://www.interaktonline.com/ - 33 – 

 

 Hit Finish to close the dialog box. 
 

 

5. Next you have to turn each image into a link that will display the image at its actual size. To do 
so, select the image, and through the Make Link interface, select the full_view page, passing 
it the id_img URL parameter. 

6. Save the page and upload it to the server. It should be similar to this one: 
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Create multiple albums 
In this section you will improve the image gallery in order to group your images into albums. This 
way, it will be easier to find images that belong to a certain event, as they all will be in the same 
album. You will have to modify several files: the menu, the upload and the display. Also, each Show 
thumbnail server behavior will have to be modified, as you will store images belonging to a certain 
album into its own folder. 

First, create the menu that will allow choosing the album to view: 

1. Open the menu.php page in Dreamweaver. 

2. Create a recordset with all the albums (similar to the one created in the List images and 
show thumbnails page). 
 

 

3. Use a dynamic table to create a navigation menu with all the albums from the recordset. This step 
is similar to the one in the List images and show thumbnails page. 

4. Now you will link each menu entry to the album.php page and add an URL Parameter, id_alb 
with the id_alb recordset value. Add an extra column to the dynamic table by selecting the table 
and incrementing the Cols field in the Properties panel. 
 

 
      
Arrange the dynamic table to look something like this: 
 

 
                      
Right click on the view album text, and select the Make Link option. In the interface, add the 
id_alb parameter, and link to the album page. 



InterAKT Online   Image Gallery Tutorial 

 

_________________________________________________________________________________ 

http://www.interaktonline.com/ - 35 – 

 

Open the album page. You will create the page in a similar way to the thumb_view page by creating 
a recordset and adding a dynamic table. Add a recordset to grab records from the album_alb table, 
and filter it using the id_alb URL parameter. This way, only images in the selected album are 
displayed. 
 

 

 

Now use a dynamic table from the Application tab of the Insert bar to list the results from the 
recordset above. 

Next you have to modify the image upload page: 

1. Open the \admin\upload_img page. 

2. Add a recordset with all the albums from the album_alb table. 

3. Next, you're going to add a drop down menu to the image upload form. The menu will contain all 
the album names, allowing you to specify which album the image will be uploaded to. 

 Add a new row to the form table, above the file field that allows browsing for an image: 
 

 
 

 In the header column, enter the "Album:" text. 
 

 
 



InterAKT Online   Image Gallery Tutorial 

 

_________________________________________________________________________________ 

http://www.interaktonline.com/ - 36 – 

 

 In the second column of the newly inserted row place a List/Menu form element, from 
the Forms tab of the Insert panel, by pressing its corresponding button. 
 

 
 

 After you've inserted the List/Menu form element, you can determine what values it 
will display by using the Property Inspector. Since the drop-down menu will use album 
titles as they are stored in the database table, hit the Dynamic button. 
 

 

 In the user interface that opens, you can add static options, that will be displayed 
regardless of what is in the table, and also options for the truly dynamic data: the 
recordset to retrieve data from, the Values column and the Labels column. Configure 
the dialog box as you can see below, based on the recordset created on the first step. 
 

 
 

4. Now the form element that allows choosing an album is displayed in the page, but when the 
actual insert transaction is executed, it is completely ignored. That is because the field was not 
associated to a database column when the insert transaction was added to the page. To add it 
now, you have to edit the Insert Transaction server behavior by double-clicking its name in the 
Server Behaviors tab. 



InterAKT Online   Image Gallery Tutorial 

 

_________________________________________________________________________________ 

http://www.interaktonline.com/ - 37 – 

 

 

 

5. When the dialog box opens, switch to the Fields tab. Press the Plus (+) button on top of the 
Fields grid, and in the window that opens, select the idalb_img field from the list. Click OK to 
close this window and return to the Insert Record Transaction interface. In the Fields grid, 
click on the newly added field. 
Using the interface controls below the Fields grid, proceed with the following settings: 

o In the Submit as drop-down menu select Numeric. 

o In the Form field drop-down menu select form1.select. 
 

 

6. Click OK to close the dialog box. 

7. You also need to modify the generated server behavior for uploading the image by specifying the 
dynamic upload folder. Open the server behavior by double-clicking its name in the Server 
Behaviors tab and add a dynamic value next to the Upload folder name. To add the album ID 
to the path, click the InterAKT Dynamic Data icon and select the transaction field idalb_img. 
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8. In the last step, you modified where uploaded images will be stored. Therefore, the last thing to 
fix is the Show thumbnail server behavior. Actually you need to modify every Show thumbnail 
server behavior used in the site. This is because the path to where images are stored has 
changed. To change the folder name to a dynamic value, you will do something similar to step 5 
above. 
Go to any page that uses a Show thumbnail behavior - thumb_view, for example. In the 
server behaviors list, double-click on the Show Thumbnail behavior to open its dialog box: 
 

 
 
In the interface that appears, select the dynamic data icon (blue icon bolt) next to the image File 
folder field: 
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Use the idalb_img field from the rsImages recordset. 
 

 
            
Now the Show thumbnail behavior should be pointing to the correct album folder: 
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Redesign the gallery with MX Includes 
The current organization of the gallery files does not allow simple navigation through all of the albums 
and pictures. That is why in this tutorial section you will enhance the gallery, by putting all the 
elements that make up the gallery in a single page. You will reuse the pages created so far, using MX 
Includes, which allows placing existing files within a single page in a static or dynamic way. 

On the gallery home page (index.php), you will place the following elements: 

 A menu listing all the albums, linked to display the images in each specific album. 

 The center of the page will display different pages, depending on the value of an URL 
parameter. If an album hasn't been selected yet, the page containing the random image and 
the latest 5 additions to the gallery will be displayed. 

 When a thumbnail is clicked, the center of the gallery home page will display the full-sized 
image. 

MX Includes is a tool that allows easy code-reuse, incorporating already made pages into others, in a 
static or dynamic manner. To learn more about this product, please see Reuse content: Server-Side 
Includes. 

Before actually creating the main page, you must decide what files will be used, and if they require 
any modifications:  

 The default.php file in the site root containing the random image and the most recently 
uploaded images will be displayed when no other action is taken, in the main page center. 

 The album.php page will be displayed in the main page when a link from the menu is 
clicked, showing the images in that particular album. 

 The full_view.php file will be used on the main page to show the images at their original 
size. 

 The menu.php will be statically included in order to allow site visitors browse the albums. 

The menu file requires some modifications, as all of its links point to the album.php page. 

Next you have to modify the menu to be displayed in the home page. To do so, follow the next steps: 

1. Open the menu.php file in Dreamweaver. 

2. Link each album title to the index.php page, because the menu, as well as the images will be 
displayed there. The links must also pass the id_alb URL parameter, as well as a static 
parameter, which will be used to determine which page to load in the index file: Set its name to 
mod, and its value to album. 
 

 

3. If needed, trim the table rows and columns so that the browser view will appear like the image 
below. Save the file and close it. The browser preview will simply display a set of links: 
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The next file to be changed is default.php: 

1. Open the default.php file in Dreamweaver. 

2. Select the show thumbnail translator in the Horizontal Looper. This is the one used to display 
the latest 5 additions. 

3. Change its link, so that it will point to the index.php page. Leave the id_img parameter in 
place, and also add another: name: mod, value: detail, similar to the image above. 

4. Save the page and close it for now. 

 

It is time to begin creating the site's new main page. To do so, follow the instructions below: 

1. Open the index file in Dreamweaver. 

2. Add a new table containing 2 rows and 2 columns. Set the border to 0. 

3. Click in the second row's first column. This is where the menu will be displayed. 

4. Apply the Server-Side Include server behavior from Server Behaviors -> + -> MX 
Kollection -> MX Includes. 

5. Use the Browse button to select the menu file and click the OK button to close the dialog box. 
Now the menu will appear on page. 
 

 
  

6. Click in the second row's second cell. This is where different pages will load, depending on an URL 
parameter. This parameter will be called mod (from mode). 



InterAKT Online   Image Gallery Tutorial 

 

_________________________________________________________________________________ 

http://www.interaktonline.com/ - 42 – 

 

7. Apply the Server-Side Includes From List server behavior from Server Behaviors -> + -> 
MX Kollection -> MX Includes. 

8. To configure the Basic tab, enter the next 3 value/page to load/title groups: 

 URL value: leave empty; Filename: default.php; Title: Welcome to the Image Gallery 

 URL value: album; Filename: album.php; Title : Images in album. 

 URL value: detail; Filename: full_view.php; Title: Image details. 
 

 
 

9. To configure the Parameter tab, enter mod in the respective text box: 
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10. Click OK button to close the dialog box. 

11. Save the page and preview it in the browser. The default page that opens displays the random 
image, as well as the latest 5 additions. 
 

 

 

There is still one more tweak before your gallery is ready. When you click on an image to see it full 
scale, it opens the full_view page, instead of the new home page. This is what you will have to 
change next: edit the links on the images. 

Open the album page in Dreamweaver. You will have to edit the links on images, so that it will open 
the correct page with the right parameters.  
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1. Click on the image placeholder, and edit the link so that it will point to the index file. Leave the 
id_img parameter, as it is handled by the full_view page, and also add the mod parameter. Set 
its value to detail, as configured in the Server-Side Includes From List server behavior. 

2. Close the page and save it. 
Now, when you click on an image, it will open it at full scale inside the index file, displaying the menu 
as well: 

 

 
   
You only have to do one more thing before calling it a wrap: add a link that will take the visitor to the 
home page. In the index page, click in the first row's first cell, and type Home, or add a logo. Using 
the Make link dialog box, set it to point to the index file without any kind of parameter. 
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Enjoy the Image gallery you've created, and store as many pictures as you wish in how many albums 
you have. If you want to further enhance your application, you can add the possibility for users to 
comment on each image, or even add images of their own, by allowing them to register on your site.  
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Apply CSS to the Image Gallery 
Although the Image Gallery is now completely functional, the front-end is not exactly pretty. In this 
page you will create a CSS stylesheet, and define your own styles to jazz up the index page.  

1. To define a new stylesheet, go to the design panel and click the New CSS Style button as shown 
below: 
 

 

2. This will bring up the New CSS Style interface, where you define a new style, and the stylesheet 
file to contain it. In this case, you will be creating a new file: 
 

 

3. Save As 
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4. Aligning table cells at the top: 
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5. Specify settings for your new style: 
 

 

6. Adding class to a specific element: 
 

 

7. Modify existing style: 
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Other Resources 

Other Dreamweaver Extensions from InterAKT 

 KTML 

 MX Kart 

 MX Site Search 

 MX RSS Reader-Writer 

 MX Dynamic Table Sorter 

 MX Coder Pack 

 MX Dynamic Charts 

 MX CSS Dynamic Menus 

 

Contact Us 

 Address: 

1-11 Economu Cezarescu ST, AYASH Center, 1st floor 

Sector 6, ZIP 060754, Bucharest, Romania  

 Web: http://www.interaktonline.com/ 

 E-mail: contact@interaktonline.com  

 Phone: +4031 401.68.19 or +4021 312.51.91  

 Fax: +4021 312.53.12 

http://www.interaktonline.com/go/KTML/?from=pdf_tut
http://www.interaktonline.com/go/MXKart/?from=pdf_tut
http://www.interaktonline.com/go/MXRSSReader-Writer/?from=pdf_tut
http://www.interaktonline.com/go/MXDynamicTableSorter/?from=pdf_tut
http://www.interaktonline.com/go/MXCoderPack/?from=pdf_tut
http://www.interaktonline.com/go/MXDynamicCharts/?from=pdf_tut
http://www.interaktonline.com/go/MXCSSDynamicMenus/?from=pdf_tut
http://www.interaktonline.com/
mailto:contact@interaktonline.com" 
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Copyright 
Windows is a trademark of Microsoft, Inc. 

Dreamweaver MX is a trademark of Macromedia, Inc. 

Redhat is a trademark of Redhat, Inc. 

 

Copyrights and Trademarks 

Copyright 2000-2005 by InterAKT Online. 

All Rights Reserved. This tutorial is subject to copyright protection. 

PHAkt, ImpAKT, NeXTensio, MX Query Builder, Transaction Engine, MX Includes, KTML, MX 
Kommerce, MX Kollection, MX Widgets, MX Looper, MX Dynamic Charts, MX CSS Dynamic Menus, MX 
Tree Menu, MX Form Validation, MX File Upload, MX Send E-mail, MX User Login, MX CSV Import-
Export, MX Kart, MX Site Search, MX Dynamic Table Sorter, MX RSS Reader-Writer, MX Coder Pack, 
MX Dynamic Charts are trademarks of InterAKT Online. 

All other trademarks are acknowledged as the property of their respective owners. 

This document and the product to which it pertains are distributed under licenses restricting their use, 
copying, distribution, and decompilation. 

No part of this document or of the associated product may be reproduced in any form by any means 
without prior written authorization of InterAKT Online, except when presenting only a summary of the 
tutorial and then linking to the InterAKT website. 

DOCUMENTATION IS PROVIDED “AS IS” AND ALL EXPRESS OR IMPLIED CONDITIONS, 
REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE 
EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. 

Send comments and suggestions to products@interaktonline.com 
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